PDF to AFP Converter
© 2014 IPDS Printing Solutions SV

Note:
To change the product logo for your ow n print manual or
PDF, click "Tools > Manual Designer" and modify the print
manual template.

Title page 1
Use this page to introduce the product
by IPDS Printing Solutions SV

This is "Title Page 1" - you may use this page to introduce
your product, show title, author, copyright, company logos,
etc.
This page intentionally starts on an odd page, so that it is on
the right half of an open book from the readers point of view.
This is the reason why the previous page was blank (the
previous page is the back side of the cover)

PDF to AFP Converter
© 2014 IPDS Printing Solutions SV
All rights reserved. No parts of this work may be reproduced in any form or by any means - graphic, electronic, or
mechanical, including photocopying, recording, taping, or information storage and retrieval systems - without the
written permission of the publisher.
Products that are referred to in this document may be either trademarks and/or registered trademarks of the
respective owners. The publisher and the author make no claim to these trademarks.
While every precaution has been taken in the preparation of this document, the publisher and the author assume no
responsibility for errors or omissions, or for damages resulting from the use of information contained in this
document or from the use of programs and source code that may accompany it. In no event shall the publisher and
the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused
directly or indirectly by this document.
Printed: December 2014 in (whereever you are located)

Publisher
...enter name...
Managing Editor
...enter name...
Technical Editors
...enter name...
...enter name...
Cover Designer
...enter name...
Team Coordinator
...enter name...
Production
...enter name...

Special thanks to:
All the people who contributed to this document, to mum and dad
and grandpa, to my sisters and brothers and mothers in law, to our
secretary Kathrin, to the graphic artist who created this great product
logo on the cover page (sorry, don't remember your name at the
moment but you did a great work ), to the pizza service down the
street (your daily Capricciosas saved our lives), to the copy shop
where this document will be duplicated, and and and...
Last not least, we want to thank EC Software who wrote this great
help tool called HELP & MANUAL which printed this document.

4

PDF to AFP Converter

Table of Contents
Foreword

6

Part I Introduction

8

1 Overview
................................................................................................................................... 8
2 What is
...................................................................................................................................
AFP
9
3 What ...................................................................................................................................
is AFPDS
10
4 What ...................................................................................................................................
is AFP Architecture
10
5 Why use
...................................................................................................................................
AFP
11
6 PDF to
...................................................................................................................................
AFP Transform Advantages
12
7 Ways...................................................................................................................................
to convert PDF to AFP
12

Part II Features

15

Part III Known Issues

18

Part IV Installing

20

1 Overview
................................................................................................................................... 20
2 Silent...................................................................................................................................
Install
21
3 Proxy...................................................................................................................................
Settings
21
4 Central
...................................................................................................................................
Deployment
22

Part V Using PDF2AFP

24

1 Checklist
...................................................................................................................................
Before Using
24
2 Get Familiar
...................................................................................................................................
with the UI
24
3 Output
...................................................................................................................................
Options
26
4 Conversion
...................................................................................................................................
Options
26
5 Step by
...................................................................................................................................
Step Instructions
27
6 Advanced
...................................................................................................................................
Options
31
AFP Output Type
.......................................................................................................................................................... 32
Creating an.........................................................................................................................................................
overlay
34
Creating a .........................................................................................................................................................
document
35
Creating a .........................................................................................................................................................
page segment
37
Creating a .........................................................................................................................................................
medium overlay
40
Page Setup .......................................................................................................................................................... 41
Paper Size......................................................................................................................................................... 42
Page Orientation
......................................................................................................................................................... 43
Clipping
.......................................................................................................................................................... 44
Clip Method......................................................................................................................................................... 45
Clip Area ......................................................................................................................................................... 46
Medium Origin
......................................................................................................................................................... 47
Measurement
......................................................................................................................................................... 48
Im age Options.......................................................................................................................................................... 49
© 2014 IPDS Printing Solutions SV

Contents

5

Color Options
......................................................................................................................................................... 50
Graphics Options
......................................................................................................................................................... 51
Grayscale .........................................................................................................................................................
Method
52
Compression
.........................................................................................................................................................
Method
53
Intensity and
.........................................................................................................................................................
Contrast
54
Inline Form Definition
.......................................................................................................................................................... 54
Duplex Options
......................................................................................................................................................... 55
Finishing Options
......................................................................................................................................................... 56
Destination.........................................................................................................................................................
Bin Options
57
Medium Overlay
.........................................................................................................................................................
Options
57
Form To Tray
.........................................................................................................................................................
Assignment Options
57
Font Options .......................................................................................................................................................... 58
EBCDIC ......................................................................................................................................................... 59
Use Text Rules
......................................................................................................................................................... 60
Maintain Text
.........................................................................................................................................................
Order
61
Font Type ......................................................................................................................................................... 62
Text Support
......................................................................................................................................................... 63
Font Substitution
......................................................................................................................................................... 64
For Font
......................................................................................................................................... 65
Use AFP Character
.........................................................................................................................................
Set
66
TrueType Font Options
......................................................................................................................................... 67
Code Page......................................................................................................................................................... 68
Output Fidelity
......................................................................................................................................................... 69
Print text as im
..........................................................................................................................................................
age
70

Part VI More Advanced Options

73

1 Color...................................................................................................................................
Management
73
2 Image...................................................................................................................................
Resolution
73
3 Image...................................................................................................................................
Compression
74

Part VII Viewing AFP

76

1 IBM AFP
...................................................................................................................................
Workbench Viewer
76

Part VIII Purchase

79

Part IX Registration

81

Part X Support

83

Index

0

© 2014 IPDS Printing Solutions SV

5

6

Foreword

Foreword

This is just another title page
placed between table of contents
and topics

© 2014 IPDS Printing Solutions SV

Top Level Intro
This page is printed before a new
top-level chapter starts

Part

I

8

1

PDF to AFP Converter

Introduction

User's Manual
for

PDF to AFP Converter

(C) Copyright 2010-2015 IPDS Printing Solutions SV. All Rights
Reserved

Designed for Windows 10/8.1/8/7/Vista/XP/2000
and Windows Server
1.1

Overview
This User Guide describes how to convert from Adobe Portable Document
Format (PDF) to Advanced Function Printing (AFP) on Microsoft Windows
platforms.
IPDS Printing Solutions SV offers software solutions specifically
designed for high performance PDF to AFP conversion. Powered by our
leading PDF to AFP transform and conversion technology, users can
quickly convert PDF to IBM MO:DCA (AFP, IOCA and PTOCA) documents.
Unlike other software solutions that simply rasterize the PDF document
to full-page images, PDF to AFP Converter maintains all document
objects such as vector graphics, searchable text, tables and live forms,
© 2014 IPDS Printing Solutions SV
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uniquely within the generated AFP for easy access by AFP Workbench
Viewer or any other AFP viewers.
This document is intended for customers, business partners, and
systems specialists who need to understand the fundamentals of
PDF2AFP conversion on Windows NT based systems.

1.2

What is AFP
Advanced Function Printing (AFP) is a document format and presentation
architecture originally developed by IBM to drive its printers and support
the production of variable data printing on laser printers, and later
provides for document and information presentation independent of
specific applications and devices.
The first software program to produce this format and to drive the IBM
printers was the so called Print Service Facility (PSF), which is still until
today found in IBM's Mainframes. PSF is fed with the input data to be
printed and the definitions on how to organize the data on the page, i.
e. PAGEDEF (Page Definition) and FORMDEF (Form Definition). It allows
electronic forms to be printed on named OVERLAYS.
PSF is not only able to format the documents, but also to drive the AFP
printers, or the Intelligent Printer Data Stream (IPDS) compatible
printers to be more precise. IPDS is a host-to-printer data stream used
for AFP subsystems that provides an attachment-independent interface
for controlling and managing.
IPDS format is a bidirectional format where the software is constantly in
control of the printer and knows at all times the status of the pages
that were sent to the printer, making it an ideal format for high volume
production printers, that print hundreds of pages within a minute.
IBM also offered the PSF software to drive the IPDS printers using the
AFP format not only on the mainframe, but also on all of the their
platforms, so there were PSF/390 (for the OS/390 mainframe), PSF/6000
(for the RS/6000 AIX9), PSF/400 (for the AS/400) and PSF/2 running
under OS/2. Unfortunately all of these behaved slightly different and
IBM renamed PSF then into IBM InfoPrint Manager.
In 1984 when storage space was still an expensive commodity, the AFP
format was designed to be very small, which is why still today it is a
very popular format for data exchange that seconds to Adobe Portable
Document Format (PDF) and to manage high volumes of documents,
such as banks, telecoms and insurances. The format originates from the
MVS environment so it typically uses the EBCDIC based codepages. As
with all page description languages (like PostScript, PDF, and PCL) it is
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necessary to use a viewer, usually it's the widely-used viewer, IBM AFP
Workbench Viewer, in order to display the pages.
One of the more notable features of AFP printers is that output data can
be placed at any addressable point on a page. This capability is called
all points addressability (APA). APA gives AFP prints the freedom to
create output anywhere on a page, as opposed to being limited to just
line and character positions.

1.3

What is AFPDS
AFPDS stands for Advanced Function Printing Data Stream, which is a
data stream for advanced function printers independent of operating
systems, independent of page printers, and portable across
environments.
AFPDS is a structured data stream divided into components called
objects. AFPDS includes text, images, graphics, and barcodes and
references AFP resources (for example, overlays, page segments, and
fonts).

1.4

What is AFP Architecture
The AFP architecture consists of a number of sub-architectures:
MO:DCA-P (Mixed Object:Document Content Architecture-Presentation):
MO:DCA-P is occasionally called AFPDS (AFP Data Stream), which is a
PDL (Page Description Language) file format that describes the text and
graphics on a page. The 'Mixed Object' moniker refers to the fact that a
MO:DCA file can contain multiple types of objects, including text,
images, vector graphics, page separators, patch code, and barcodes. An
application can simply include a string of digits along with controls that
identify a specific type of barcode, and the rendering of bars will be
performed on the output platform via either physical printer hardware or
software emulation. A MO:DCA document consists of a sequential,
ordered hierarchy of independent objects - documents, pages, data
objects, and such resource objects as fonts and ICC profiles. Each
object is delimited by one or more begin/end structures, and objects to
be rendered specify presentation parameters and resource requirements
in structures called "environment groups". Since the pages in MO:DCA
documents are organized in sequential order, presentation can start as
soon as the first page is received. The MO:DCA format is comparable to
other PDLs such as Adobe PDF that specify distinct pages.
IPDS (Intelligent Printer Data Stream)
Known as a bi-directional protocol used between the host and the
© 2014 IPDS Printing Solutions SV
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printer, IPDS is used to send the page-level data to the printer and to
signal errors and accounting information back to the host server. The
IPDS protocol, comparable to protocols like IPP (Internet Printing
Protocol), allows the server to query a printer's available resources such
as available memory, fonts, input trays, etc.
BCOCA (Bar Code Object Content Architecture)
BCOCA is used to describe and generate barcodes such as PDF417.
CMOCA (Color Management Object Content Architecture)
CMOCA defines resources that carry color management information, such
as ICC profiles, tone transfer curves, and halftones.
AFP GOCA (Graphics Object Content Architecture for AFP)
AFP GOCA is used to define and generate vector graphics.
IOCA (Image Object Content Architecture)
IOCA is used to define and generate raster images.
PTOCA (Presentation Text Object Content Architecture)
PTOCA is used to define and generate text.
AFP also supports other industry-standard data formats using the
concept of AFP object containers; examples are TIFF, GIF, JPEG (JFIF),
EPS, and PDF. These objects can be mixed as peer objects on an AFP
page with native AFP objects such as BCOCA, AFP GOCA, IOCA, and
PTOCA objects.

1.5

Why use AFP
AFP (Advanced Function Printing) enables users to control formatting,
the form of paper output, how a document is to be printed or viewed,
and manage document storage and access in a distributed network
across multiple operating system platforms. AFP is primarily employed in
large enterprises for production variable data printing (VDP).
AFP applications allow users or print room operators to distribute print
jobs among a group of printers or in a printer farm, and to designate
backup printers when one fails, which is called failover. In publishing
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AFP is considered to be a cornerstone of electronic document
management (EDM) applications such as print-and-view, archive and
retrieval, and Enterprise Report Management (ERM).

1.6

PDF to AFP Transform Advantages
PDF to AFP Conversion Advantages including but not limited to,
•PDF file created in any application can be converted to an AFP file, and
dynamically inserted into an AFP datastream on an IBM iSeries, zSeries,
and AS/400
•Archive Adobe Portable Document Format in IBM and Infoprint AFP/
IPDS format
•Avoid costly changes or replacement of your AFP based print
applications
•Easy integration with IBM iSeries, zSeries, AS/400 applications
•Avoid new investment on PDF processing software
•Eliminate the costly acquisition of Adobe Acrobat or Adobe LiveCycle
products
•Accelerate the delivery of reports generated on Windows platforms.
•Lessen storage budget for hard copy reports
•Easier reorganization of data in documents and reports by using AFP
technologies
•Increase efficiency of information combination and reuse
•Reduce risk by geographically distributing data on IBM platforms
•Distribute transformed AFP/IPDS documents across IBM and Infoprint
printing systems.

1.7

Ways to convert PDF to AFP
There would be two ways to perform PDF to AFP transform.
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The easiest way is to convert the PDF to a series of TIFF images and rewrite the
AFP stream to include them as IOCA images. If they are two-color fax G4
compressed, they can be converted to IOCA group 10 without much trouble.
The second way is to convert the PDF to AFP and rewrite the AFP stream to
include it. If the PDF doesn't have embedded fonts then you shouldn't have
too much trouble mapping the fonts to the AFP ones.
The first way generates full-page images, i.e. rasterized AFP pages, text is not
searchable, graphics is not vector based. It may not look quite right at first
impression.
PDF to AFP Converter (PDF2AFP) follows the second way and generates fulltext searchable AFP files with vector based graphics.
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Features
PDF2AFP key features include,
• Convert PDF to AFP streams in batch at unlimited speed
• Perform object-to-object conversion from PDF to AFP
• Transform PDF into live AFP that contains text as searchable text and
graphics as vector graphics, not just rasterize
• Support monochrome, color-white, 16-color, and full color graphics
• Automate conversion from PDF form template to AFP and load it to AS400,
iSeries, or zSeries mainframe
• Adaptive PDF to AFP transform such as to handle many smaller PDFs or a
few much larger PDFs
• Optimize conversion from PDF to AFP either by speed or by quality
• Translate fill-able form in PDF files to inline form in AFP documents
• Support full color conversion of PDF pages to AFP pages
• Import PDF files from Windows local or network shared folders
• Speedy conversion to efficiently handle production sized jobs
• Sharpen image and graphics in AFP output
• Produce high fidelity AFP to the original print in PDF format
• Support a complete set of paper sizes
• Define custom paper size
• Flexible page orientation such as Portrait, Landscape, Portrait 180,
Landscape 270
• Clip unprintable area or offset plus size
• Grayscale methods including photographic dither, compressed dither,
diagonal dither, line art halftone
• Color options for mono, color/white, 16 colors (4bit CMYK from 4bit RGB or
24bit RGB), and Full Color 32bit CMYK
• Color Management with ICC Profiles
• Adjust image resolution between 300x300 and 600x600 dpi
• JPEG and LZW compression algorithm for images
• Easy Intensity and Contrast Controls
• Best output fidelity for TrueType fonts as references, inline resources, or
images
• Optimize text in OpenType fonts, raster fonts, and outline fonts
• Maintain Output Fidelity for placement in character, word, and line level
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• Font substitution of AFP character set with closely matched Windows font
• Support Inline Form Definition
• Produce AFP output files as smaller as possible
• Flexible file extension for AFP documents, page segments, medium overlays,
and overlays
• Output AFP files can be emailed, saved to a folder on your computer, copied
to a network location, uploaded to a host platform via FTP, or sent to an AFP/
IPDS capable printer.
• Automatic installation and configuration on Windows x86 and Windows x64
• Live update for newer versions on Windows 32-bit and Windows 64-bit
• Free upgrades for registered users
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Known Issues
The following limitations apply to the PDF to AFP transform:
1. Adobe Reader needs to be installed and launched with the end-user license
agreement accepted before it can be used for PDF to AFP conversion.
2. Adobe Reader or Adobe Acrobat is suggested to be the default application to
open, view, and print PDF documents. Other 3rd-party PDF viewer or reader
might not be supported.
3. The transform cannot process DBCS fonts very well.
4. Resolution conversion algorithms might produce a degraded appearance
when used to reduce the resolution of images imbedded in a data stream. For
this reason, the transform might degrade the appearance of higher-resolution
images when used with 240-pel printers. You should verify that print fidelity is
satisfactory.
5. For certain PDF files, the transform does not produce color output, and it
produces monochrome output only.
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Installing
This chapter introduces the concept of software installation on Microsoft
Windows, how to adjust proxy settings in a corporate environment, and
how to deploy PDF to AFP Converter (PDF2AFP) in a centralized
environment.
Before installing the PDF2AFP software, please make sure that the
following hardware requirements are met,
Intel or AMD processor 1.7GHZ or better
200MB free disk space
1024x768 or higher resolution for Display Monitor
Microsoft Windows 10/8.1/8/7/Vista/XP/2003/2008/2012 Server
[32bit/64bit]
Adobe Reader installed
PDF to AFP Converter working on Windows 64-bit operating systems
outperform approximately 30% in performance over working on 32-bit
operating systems.
Note: This PDF2AFP conversion software run on Microsoft Windows NT
based operating systems only, and it cannot be launched on OS/390, z/
OS, Linux, Solaris, UNIX, or AIX systems.

4.1

Overview
Before installing PDF to AFP Converter, make sure that you have
Windows Print Spooler service enabled. This service is by default
enabled by Microsoft Windows, and it is required by PDF to AFP
Converter as well as required by all Inkjet and Laserjet printers.
To enable the Print Spooler service, just click Start->Run, and type in
the following command,
SC.EXE start Spooler
The file name of the installer for PDF to AFP Converter is
PDF2AFP_Setup.exe. And the installer installs an evaluation copy of the
PDF to AFP Converter for users to try for up to 15 days.
To facilitate the installation, you are required to log on Microsoft
Windows as Administrator or a Power User with the rights to install
software. After you download PDF2AFP_Setup.exe from the web or
obtain the file from a 3rd-party source, you need to right-click on the
file, and choose 'Run As Administrator' on Microsoft Windows 7 and later
operating systems to ensure that the installer is executed with elevated
© 2014 IPDS Printing Solutions SV
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privilege so that installation won't fail.
The file name 'PDF2AFP_Setup.exe' is for the trial version of the PDF to
AFP Converter, and the one for the full retail version differs.

4.2

Silent Install
PDF to AFP Converter can be installed in a completely silent way without
any user interaction.
To start a silent installation, start the installer with the following
switches,
PDF2AFP_Setup.exe /SP- /VERYSILENT
Sometimes a certain driver file might be in use by an application, and
the file has to be replaced during next reboot. In this case, the installer
might prompt user to restart the computer. To suppress the information,
just use the following switches,
PDF2AFP_Setup.exe /SP- /VERYSILENT /NORESTART
If you need MSI package for installation, feel free to contact
support@ipdsprinter.com.

4.3

Proxy Settings
The installer of PDF to AFP Converter always perform a check to see if a
new version of the PDF2AFP core component is available on the web,
and therefore an active Internet connection is highly desired by the
installer.
In a corporate environment the users have to specify a proxy server to
have access to the Internet in the web browser. The installer of the PDF
to AFP Converter is able to detect the proxy settings specified in
Microsoft Internet Explorer.
If you haven't set up your proxy server, you can click Start->Run, and
then type in the following command,
Rundll32 Shell32.dll,Control_RunDLL Inetcpl.cpl,,4
and then specify the proxy server name (or IP address), and the proxy
server port.
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Central Deployment
To deploy PDF to AFP conversion capability across your organizations,
you need to install PDF2AFP Transform Server software.
This PDF2AFP Transform Server program allows your users to drop in AFP
documents in an incoming folder, and immediately after the software
processes the incoming PDF files, they are converted to AFP documents.
In this way the PDF2AFP Transform Server servers as an efficient serverside PDF to AFP Converter.
More information on PDF to AFP Transform Server product can be
found in our web site,
http://www.ipdsprinter.com/pdf2afp-transform-server.html
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Using PDF2AFP
This chapter covers the following topics,
1.
2.
3.
4.
5.
6.

5.1

Checklist before using the software
Get familiar with the user interface
Output options
Conversion options
Advanced options
Step-by-step instructions for using the PDF2AFP conversion software

Checklist Before Using
Before the first launch of PDF to AFP Converter, you need to review the
following checklist,
1. Is Adobe Reader or Adobe Acrobat installed? Adobe Reader can be
any version of Adobe Reader, such as Adobe Reader 7, Adobe Reader 8,
Adobe Reader X, Adobe Reader XI. If you have already acquired Adobe
Acrobat, you should make sure that Adobe Acrobat is installed.
2. Have you ever used the Adobe Reader and accepted the end-user
license agreement and chosen the UI language of your preference? If
the end-user license agreement is not accepted or the UI language is
not selected, the batch conversion from PDF to AFP would probably fail.
3. Make sure that you can open and read an AFP file on your computer.
4. Be aware of the AFP Printer is available in your printer list.
5. Delete all temporary files in your C:\IPDSCache folder only if the
folder exists.

5.2

Get Familiar with the UI
Let's get familiar with the graphical user interface on the first launch of
PDF to AFP Converter after install.
On the top of the user interface, there exist six buttons. The
functionality of each can be,
Add File(s)...: Add one or more PDF files. Once this button is clicked, a
select file dialog appears, and you can hold the Shift key on your
keyboard to select multiple PDF files.
Add Folder...: Add all PDF files in a specified folder. If this button is
clicked in the mean time the 'Include subfolder(s)' option is checked,
© 2014 IPDS Printing Solutions SV
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you will see a folder selection dialog, and be able to automatically
import all the PDF files in all of the subfolders of the folder that have
just specified.
Remove: Delete one or more selected PDF files from the list of the UI.
The actual files are not erased from your storage.
Remove All: Delete all PDF files in the list of the UI. The actual files are
not erased from your storage.
Convert: Once this button is clicked, the conversion begins, and this
button will be changed to a Stop button.
Buy Now: To purchase a license online.
Help: Load this user guide. This button is not available in the evaluation
copy.

Down the list of PDF files, you see Output Options and Conversion
Options. More details will be disclosed in the subsequent topics.
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Output Options
You can choose to output AFP files in the same folder of the PDF files or
to output AFP files to a specific folder of your preferences. This folder is
also called target folder.
Keep tree structure for AFP files: this option enables the output AFP
files to be created with hierarchical folder structure in the target folder.
Delete AFP file after conversion: the source PDF file will be erased once
it is converted to AFP file.

5.4

Conversion Options
In the Conversion Options area, you can customize the file extension for
output AFP file. This feature is most frequently used when users wish to
distinguish AFP document, page segment, medium overlay, and overlay
with the different file extensions on Microsoft Windows
10/8.1/8/7/2000/XP/2003/Vista/2008/2012 and later operating systems.
The default file extensions are,
© 2014 IPDS Printing Solutions SV
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Document: *.afp, *.AFP
Page Segment: *.psg,*.PSG
Medium Overlay: *.oly,*.OLY
Overlay: *.oly,*.OLY

An important option is the conversion optimization mode; you can
choose either High Quality or High Speed.
High Quality uses industrial-strength PDF to AFP transform algorithms.
High Speed optimizes the conversion work flow, and generates the AFP
documents at high speed.

5.5

Step by Step Instructions
Here is an example on how to use PDF to AFP Converter to batch several
AFPs to PDFs.
1. Launch PDF to AFP Converter
2. Click 'Add File(s)...' button, select one or more PDF files
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3. Repeat Step 2 until you have no more PDF files to add in the same or
the other locations
4. Set the Output Options, Output AFP files to a specific folder, here the
specific folder is D:\IPDS
5. Set the Conversion Options, High Quality

6. Click 'Advanced Options...' button to adjust the paper size to A4
(210x297 mm)
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7. Click OK button to close this AFP Advanced Options dialog
8. Now click 'Convert' button to start the PDF to AFP transform,
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All selected PDF files would be processed, and stored in AFP format in
the D:\IPDS folder after the PDF to AFP conversion.
You can click Stop button (Convert button becomes Stop button
immediately after the conversion begins) to terminate the conversion
process at any time.
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5.6

Advanced Options

Advanced Options... button resides in the Conversion Options area.
Once you click this button, you will see the following dialog,
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You can change the Paper Size, Orientation, Output Type, Inline Form
Definition, Clip Limits, Image Options and more. For more information
on the options, read the sub topics.
5.6.1

AFP Output Type
Four types of AFP output are defined by IBM Advanced Function
Presentation Architecture, document, page segment, medium overlay,
and overlay.
These output types make it possible to print PC documents on highspeed AFP system printers, produce electronic forms using your favorite
PC application, and even create signatures and logos from existing or
newly-scanned sources.
•AFP documents
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Using the AFP Printer, you can send your PC documents, such as
Microsoft Word document, Microsoft Excel document et al, for printing on
a high-speed AS/400 AFP system printer instead of overloading your
desktop PC printer.
•Page segments
Page segments are collections of predefined data that can be merged
with other data on a page when the page is printed. They generally are
used to print signatures or logos. Page segments may contain either IM
images, IO images, vector graphics, and, with some limitations, precomposed text.
IM images are supported on all AFP Advanced Function Presentation
printers. An IM image object specifies the content of an uncompressed
raster image and its placement on a page. It is resolution and
orientation. However, when printed on a printer of a different resolution
from the image, if the printer supports IO images, the IM image is
converted to IO image and scaled to the printer's resolution. This is
done for most 300-dpi printers when 240-dpi images are used.
IO images are supported only on the newer AFP Advanced Function
Presentation printers. An IO image object (also known as IOCA), also
specifies the content of a raster image. However, the image is
resolution independent and can be either uncompressed or compressed
with one of the following compression algorithms: IBM MRR, RL4, ABIC,
G3MR (CCITT T.4 G3) and G4 MRR (CCITT T.6 G4). If IO images are used
for printers that do not support them, the images will be scaled to the
printer's resolution, if necessary, and converted to an IM image at print
time.
Graphics are supported on only the newer AFP Advanced Function
Presentation printers. They are not supported on old printers. A graphic
object specifies the content of a vector graphic and it, too, is resolution
independent.
If you already have your business logos or signatures in PC format, you
can include these in overlays, or perhaps create them as a separate
resource, i.e. an AFP page segment. Captured at a PC-attached scanner,
they can be imported into a PC application and then “
printed”as a page
segment.
•Overlays and Medium Overlays
An overlay may be either a medium overlay or a page overlay (page
overlay is usually called overlay). Not all printers can support page
© 2014 IPDS Printing Solutions SV
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overlays electronic forms.
The most common overlay is the medium overlay, which can be used to
print same overlay on every page of data, print different overlays
electronic forms on different copies of the same page, or print different
overlays electronic forms on front and back of duplex page. It's a type of
overlay that is called out in a form definition to be included on one or
more pages of a document when it prints.
A page overlay is used to print different overlays electronic forms on
different pages of a job, and/or print same overlay at different locations
on different pages.
5.6.1.1

Creating an overlay

What is AFP overylay?
An overlay may be either a medium overlay or a page overlay (page
overlay is usually called overlay). Not all printers can support page
overlays electronic forms.
A page overlay is used to print different overlays electronic forms on
different pages of a job, and/or print same overlay at different locations
on different pages.
How to create AFP overlay?
1. Start your PC software (Here, we take Microsoft Excel as an example)
2. Open a Microsoft Excel spreadsheet
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window
appears,
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6. Select "Overlay" from the drop-down list of "Output Type"
7. Click "Apply" button and then click "OK" button to confirm your
changes
8. Click "OK" in the Print Dialog of Microsoft Excel to confirm your "Print"
command
9. A "Save-As" dialog will pop up, you can specify the folder and file
name of the AFP document to be created.
5.6.1.2

Creating a document

What is AFP document?
Using the AFP Printer, you can send your PC documents, such as
Microsoft Word document, Microsoft Excel document et al, for printing on
a high-speed AS/400 AFP system printer instead of overloading your
desktop PC printer.
How to create AFP document?
1. Start your PC software (Here, we take Microsoft Word as an example)

© 2014 IPDS Printing Solutions SV

36

PDF to AFP Converter

2. Open a Microsoft Word document
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window
appears,

6. Select "Document" from the drop-down list of "Output Type"
7. If you want to specify duplex printing and use a different drawer,
highlight "Inline Form Definitions" and then click the "Form
Definition..." button on the right,
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You will get the Inline Form Definition dialog,

8. You can also specify an AFP (Medium) Overlay to be printed with your
document, but you must ensure it is available as a separate resource on
the system from which you want to print.
9. Click "OK" button to close the Inline Form Definition dialog.
10. Click "Apply" button and then click "OK" button to confirm your
changes
11. Click "OK" in the Print Dialog of Microsoft Word to confirm your
"Print" command
12. A "Save-As" dialog will pop up, you can specify the folder and file
name of the AFP document to be created.
5.6.1.3

Creating a page segment

What is AFP page segment?
Page segments are collections of predefined data that can be merged
with other data on a page when the page is printed. They generally are
used to print signatures or logos. Page segments may contain either IM
images, IO images, vector graphics, and, with some limitations, precomposed text.
IM images are supported on all AFP enabled printers. An IM image
object specifies the content of an uncompressed raster image and its
placement on a page. It is resolution and orientation. However, when
printed on a printer of a different resolution from the image, if the
printer supports IO images, the IM image is converted to IO image and
scaled to the printer's resolution. This is done for most 300-dpi printers
when 240-dpi images are used.
IO images are supported only on the newer AFP enabled printers. An IO
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image object (also known as IOCA), also specifies the content of a
raster image. However, the image is resolution independent and can be
either uncompressed or compressed with one of the following
compression algorithms: IBM MRR, RL4, ABIC, G3MR (CCITT T.4 G3) and
G4 MRR (CCITT T.6 G4). If IO images are used for printers that do not
support them, the images will be scaled to the printer's resolution, if
necessary, and converted to an IM image at print time.
Graphics are supported on only the newer AFP enabled printers. They are
not supported on old printers. A graphic object specifies the content of a
vector graphic and it, too, is resolution independent.
If you already have your business logos or signatures in PC format, you
can include these in overlays, or perhaps create them as a separate
resource, i.e. an AFP page segment. Captured at a PC-attached scanner,
they can be imported into a PC application and then “
printed”as a page
segment.
How to create AFP page segment?
1. Start your PC software (Here, we take Microsoft Access as an
example)
2. Open a Microsoft Access database/document
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window
appears,
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6. Select "Page Segment" from the drop-down list of "Output Type"
7. Click "Apply" button and then click "OK" button to confirm your
changes
8. For an image that occupies most or all of the page, leave the Top/
Left and Width/Height settings at their default values. If you are
producing a company logo or signature that typically occupies a small
area of the page, you can place your logo in the top left-hand area of
the page, and then change Paper Size to User Defined (for instance,
2.0 inches wide by 1.2 inches deep). This helps reduce the amount of
surrounding white space you capture with the page segment and makes
positioning it much easier.
8'. Alternatively, you can enter the coordinates of the top left-hand
corner of the logo or area you want to capture in Top and Left in "Clip
Limits..." options dialog, and change Width and Height as required (for
instance, 2.0 inches by 1.2 inches). NOTE: This method does not work
with certain Windows applications
8". Another method is to select the Partial Print option from your
Windows application, which means that you print only an area of your
spreadsheet or drawing, but not the whole area.
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9. Click "OK" in the Print Dialog of Microsoft Access to confirm your
"Print" command
10. A "Save-As" dialog will pop up, you can specify the folder and file
name of the AFP document to be created.
5.6.1.4

Creating a medium overlay

What is AFP medium overylay?
An overlay may be either a medium overlay or a page overlay (page
overlay is usually called overlay). Not all printers can support page
overlays electronic forms.
The most common overlay is the medium overlay, which can be used to
print same overlay on every page of data, print different overlays
electronic forms on different copies of the same page, or print different
overlays electronic forms on front and back of duplex page. It's a type
of overlay that is called out in a form definition to be included on one or
more pages of a document when it prints.
How to create AFP medium overlay?
1. Start your PC software (Here, we take Microsoft PowerPoint as an
example)
2. Open a Microsoft PowerPoint slide
3. Select from main menu "File"->"Print"
4. Select Printer "AFP Printer"
5. Click the "Property" button on the right, and the follow window
appears,
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6. Select "Medium Overlay" from the drop-down list of "Output Type"
7. Click "Apply" button and then click "OK" button to confirm your
changes
8. Click "OK" in the Print Dialog of Microsoft PowerPoint to confirm your
"Print" command
9. A "Save-As" dialog will pop up, you can specify the folder and file
name of the AFP document to be created.
5.6.2

Page Setup
The AFP drivers differ from normal printer drivers in that the output is
Advanced Function Presentation Data Stream (AFPDS) instead of the
more usual Printer Control Language (PCL), Personal Printer Data Stream
(PPDS), PostScript, and others. You “
print”to the AFP Printer to obtain
the output in an AFP file just the same way as you normally print from
any Windows application to an Inkjet or Laserjet printer.
There are a variety of page setup options, among which the most
important options are paper size and page orientation.
Paper size specifies which type of media your document is printed on,
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for example, print each your Microsoft Word document page to an A4
size paper represented in an AFP document.
Page orientation describes the layout of your document, portrait or
landscape or even complex.
5.6.2.1

Paper Size

To adjust the paper size settings, you can run the following command in
Start->Run,
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
Or you can go to your Control Panel->Printers and Devices (only on
Windows 10/8.1/8/7/Vista/2008/2012) or Control Panel->Printers and
Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP
Printer", and then choose "Printing Preferences".
In the Printing Preferences dialog, you see the Paper Size option.
The following paper sizes are supported by the AFP Printer,
Letter (8.5 x 11 inch)
Legal (8.5 x 14 inch)
Ledger (17 x 11 inch)
Executive (7.25 x 10.5 inch)
Tabloid (11 x 17 inch)
Statement (5.5 x 8.5 inch)
A3 (297 x 420 mm)
A4 (210 x 297 mm)
A4 Small (210 x 297 mm)
A5 (148 x 210 mm)
B4 (250 x 354 mm)
B5 (182 x 257 mm)
Folio (8.5 x 13 inch)
Quarto (215 x 275 mm)
Note (8.5 x 11 inch)
10 x 14 inch
11 x 17 inch
Envelope B4 (110 x 230 mm)
Envelope B5 (176 x 250 mm)
Envelope B6 (176 x 125 mm)
Envelope C3 (324 x 458 mm)
Envelope C4 (229 x 324 mm)
Envelope C5 (162 x 229 mm)
Envelope C6 (114 x 162 mm)
Envelope C65 (114 x 229 mm)
Envelope DL (110 x 220 mm)
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Envelope #9 (3.875 x 8.875 inch)
Envelope #10 (4.125 x 9.5 inch)
Envelope #11 (4.5 x 10.375 inch)
Envelope #12 (4.75 x 11 inch)
Envelope #14 (5 x 11.5 inch)
Envelope Monarch (3.875 x 7.5 inch)
C Sheet
D Sheet
E Sheet
Continuous (13.2 x 8.5 inch)
Continuous (13.2 x 11 inch)
Continuous (13.2 x 14 inch)
User Defined (When this item is chosen, you are required to click the
"User Defined..." button on the right and specify the height, width, and
unit.)
NOTE: The paper size that you enter must exist on your printer, or
printing any documents that are created with this paper size may fail.
Neither height nor width must exceed the range of [1, 22].
5.6.2.2

Page Orientation

The following page orientation are supported by the AFP Printer,
Portrait
Landscape
Portrait 180
Landscape 270

To adjust the page orientation settings, you can run the following
command in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
Or you can go to your Control Panel->Printers and Devices (only on
Windows 10/8.1/8/7/Vista/2008/2012) or Control Panel->Printers and
Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP
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Printer", and then choose "Printing Preferences".
In the Printing Preferences dialog, you see the Orientation option.
5.6.3

Clipping
AFP Printer offers a Clip Limit Options dialog to indicate how the AFP
Printer should clip the output generated.
To show this dialog, you can run the following command in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
Or you can go to your Control Panel->Printers and Devices (only on
Windows 10/8.1/8/7/Vista/2008/2012) or Control Panel->Printers and
Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP
Printer", and then choose "Printing Preferences".
In the Printing Preferences dialog, you see an option "Clip Limits..." and
a button "Properties..." on the right,

Click this button, and you will get the Clip Limit Options dialog,
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Clip Method

Two kinds of clip methods are provided in AFP Printer,
Unprintable area:
This method is intended for document and medium overlays. You need
to specify the amount of unprintable area on the top and bottom of the
page, and for the left and right margins. For instance, the default
margin in your printer is set to one quarter of an inch on all sides, but
you may want to decrease this amount to take advantage of your
printer's ability to print closer to the edge.
Offset plus size:
This method is for page segments and overlays. You are required to
specify the coordinates of the top-left corner of the area to be included
in the page segment or overlay and the width and height of the area.
The following formula should be met,
1. Left offset + Width <= paper width
2. Top offset + Height <= paper height
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Clip Area

You can set the area for the actual amount to clip. The value ranges are
determined by the clip method selected.
The Top value determines how much to clip off the top of the page.
The Left value determines how much to clip off the left of the page.
The Bottom value determines how much to clip off the bottom of the
page.
The Right value determines how much to clip off the right of the page.
The Width value determines how wide the clipped output should be.
The Height value determines indicates how high the clipped output
should be.
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Medium Origin

Medium origin indicates the (X ,Y ) origin of the medium in the form
definition (FORMDEF) to be used when a document is being printed. By
default X=0.000 and Y=0.000. The upper bound for the X origin is the
Left value, and the bound for the Y origin is the Top value.
Medium origin options disappear when the Inline Form Definition is set
to On, because the medium origin always equals to (0,0) in the inline
form definition to be created.
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Measurement

The unit of measurement can either be Inch or Millimeter.
You can choose the one of your preference.
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Image Options
AFP Printer offers an Image Options dialog to indicate how the AFP
Printer should process images and graphics before generating the
output.
When you print from some Windows applications to the AFP printer,
they do not send halftone data directly to the printer, and the options
you select for Color Options, Graphics Options, Grayscale Method,
Compression Method, Intensity, and Contrast determine how your
images and graphics are printed.
You may need to experiment with these options to get the best results.
To show this dialog, you can run the following command in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
Or you can go to your Control Panel->Printers and Devices (only on
Windows 10/8.1/8/7/Vista/2008/2012) or Control Panel->Printers and
Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP
Printer", and then choose "Printing Preferences".
In the Printing Preferences dialog, you see an option "Image Options..."
and a button "Properties..." immediately on the right of the option,
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Click this button, and you will get the Image Options dialog,

5.6.4.1

Color Options

Four kinds of Color Options are available. The color option that you
select determines how your AFP document (*.AFP), page segment (*.
PSG), medium overlay (*.OLY), or overlay (*.OLY) looks like.
Back / White (B/W)
This bitonal option forces the AFP Printer to generate black and white
images. Only black and white are available in the output AFP docs.
Color / White (C/W)
This bitonal option mandates the AFP Printer to generate single color
and white images. Only the selected single color and white are available
in the output AFP docs. The single color is Black by default, and you
may change it to other colors but White as well.
16 Colors - 4Bit CMYK / From RGB
This option allows the creation of 16 colors images in the CMYK Color
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Space. The halftone algorithm is selected by the number of bits, either
4Bit or 32Bit, in the RGB Color Space.
Full Colors - 32Bit CMYK
This option allows the creation of 32-bit full-color image in the CMYK
Color Space.
NOTE: CMYK stands for Cyan, Magenta, Yellow, and Black, and RGB is
short for Red, Green, and Blue.

5.6.4.2

Graphics Options

Graphic Options determines the support level of graphics the AFP Printer
generates. Three options are provided:
None
All graphic objects are rasterized into images.
Basic
Graphic objects comply with GOCA's DR/2V0 standard, which is a
standard supported by all AFP enabled printers.
Enhanced
Graphic objects have additional drawing orders not support by GOCA's
DR/2V0 standard. Not all AFP enabled printers support the additional
drawing orders.
NOTE: GOCA is an architected collection of constructs for the
interchange and presentation of graphic data. The AFP Printer uses
constructs from the GOCA DR/2V0 and above.
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Grayscale Method

Five grayscale methods are provided,
Default Dither
This method uses a 4 x 4 bit pattern of dots to emulate up to 16 levels
of gray.
Photographic Dither
This method uses an 8 x 8 bit pattern of dots to emulate up to 64 levels
of gray, producing a smooth, realistic, and photographic appearance. If
you need soft contrasts between various shades of gray, you should not
miss this dither.
Compressed Dither
This method uses an 8 x 8 bit pattern of horizontal lines to emulate up
to 64 levels of gray, producing the smallest output, while still giving
reasonable quality. This dither should not be applied to the full color
images produced by a scanner.
Diagonal Dither
This method uses an 8 x 8 bit pattern of diagonal lines to emulate up to
64 levels of gray, producing a smooth, realistic appearance without the
graininess otherwise produced using the Photographic Dither.
Line art halftone Dither
This method uses 32 different 8 x 8 bit patterns to produce 32 distinct
levels of gray. Line art halftone Dither works well for images with
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intricate lines and fine detail such as clip art graphics. Unlike
Photographic Dither and Diagonal Dither that provide soft contrasts
between various shades of gray, the Line art halftone Dither provides
solid lines and well-defined borders between various shades of gray.

5.6.4.4

Compression Method

This option, for most cases, is grayed out, unless the Full Color - 32Bit
CMYK Color option is selected as the color option for AFP docs.
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Full color image objects can be compressed using either the LZW or the
JPEG compression algorithm. LZW compression is good for text-based
content, and JPEG compression is recommended for photographic
images.
5.6.4.5

Intensity and Contrast

Intensity Control and Contrast Control are grayed out when the
grayscale method is Default dither; they are enabled when any other
dither is selected as the grayscale method.
Intensity Control can be used to increase or decrease the lightness of
image and graphics in the output AFP docs.
Contrast Control can be used to increase or decrease the contrast of
image and graphics in the output AFP docs.
In most cases the two values do not need to be adjusted.

5.6.5

Inline Form Definition
AFP Printer offers an Inline Form Definition Options dialog to indicate
how the AFP Printer should process images and graphics before
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generating the output.
You may need to experiment with these options to get the best results.
To show this dialog, you can run the following command in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /e /n "AFP Printer"
Or you can go to your Control Panel->Printers and Devices (only on
Windows 10/8.1/8/7/Vista/2008/2012) or Control Panel->Printers and
Faxes (only on Windows 2000/XP/2003), and right-click on the "AFP
Printer", and then choose "Printing Preferences".
In the Printing Preferences dialog, you see an option "Inline Form
Definition", turn it from Off to On, and a button "Form Definitions..."
appears immediately on the right of the option,

Click this button, and you will get the Inline Form Definition dialog,

5.6.5.1

Duplex Options

Duplex Options are embedded parameters and/or commands in the AFP
docs (document, page segment, overlay, or medium overlay) to indicate
on which sides of the output sheet the target printer prints your AFP
docs. The target printer can be a consumer inkjet printer, a high-volume
laserjet printer, or a CMYK printing press.
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Simplex
Print only one side on each output sheet.
Duplex
Print both sides on each output sheet and arrange the resulting sheets
to be found on the left.
Tumble Duplex
Print both sides on each output sheet and arrange the resulting sheets
to be bound on the top.
5.6.5.2

Finishing Options

Finishing Options are embedded parameters and/or commands in the
AFP docs (document, page segment, overlay, or medium overlay) to
indicate the type of task to do at the end of printing on a document
level. For instance, if Punch is selected, and all the pages in a document
are punched.
Punch
The following types of Punch operations are supported by AFP Printer,

Staple
The following types of Staple operations are supported by AFP Printer,
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Destination Bin Options

Destination Bin Options are embedded parameters and/or commands in
the AFP docs (document, page segment, overlay, or medium overlay) to
indicate which output bin should be used by the target printer.
Zero stands for the default bin, and one stands for Bin 1, and two
stands for Bin 2 etc.

5.6.5.4

Medium Overlay Options

Medium Overlay Options are embedded parameters and/or commands in
the AFP docs (document, page segment, overlay, or medium overlay) to
indicate which medium overlay is to be included on every page of your
AFP document when the document is printed on the target printer. A
valid name of the medium overlay is required.
5.6.5.5

Form To Tray Assignment Options

Form To Tray Assignment Options are embedded parameters and/or
commands in the AFP docs (document, page segment, overlay, or
medium overlay) to match the correct paper size with each paper source
available on the target printer.
Size
A full list of available paper sizes.
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Source
A complete list of valid paper sources available on the target printer. If
the "Auto Select Bin" option is selected, Paper Type is matched to Size
to determine the media object identifier.
Paper Type
White, Color, Transparent are the three available options.
5.6.6

Font Options
AFP Printer offers an Font Options dialog to indicate how the AFP
Printer should process fonts before generating the output.
When you print from some Windows applications to the AFP printer, text
printed in a certain font might not have a substitute in your table is
printed as image. By setting up the Font Options, you can determine
which AFP character set should be substituted for particular Windows
fonts in your AFP output and what level of fidelity should be maintained.
You may need to experiment with these options to get the best results.
To show this dialog, you can run the following command in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /p /n "AFP Printer"
In the Printing Preferences dialog, you see an option "Fonts..." and a
button "Properties..." immediately on the right of the option,

Click this button, and you will get the Font Options dialog,
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EBCDIC

Extended Binary Coded Decimal Interchange Code (EBCDIC) is an 8-bit
character encoding (code page) employed mainly on IBM mainframe
operating systems such as z/OS, OS/390, VM and VSE, as well as IBM
midrange computer operating systems such as OS/400 and i5/OS (see
also Binary Coded Decimal).
When the EBCDIC option is selected, the AFP Printer will convert all
ASCII text into EBCDIC text. A valid EBCDIC code page must be
specified in the Code Page column, or the text strings would otherwise
print improperly.
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The default EBCDIC code page is T1001140.
This EBCDIC option is by default disabled.
5.6.6.2

Use Text Rules

This Use Text Rules option allows you to trade off between speed, file
size, and output fidelity.
When this option is enabled, the AFP Printer produces output files as
smaller as possible. Smaller AFP files are usually printed faster by the
target printer.
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This option is by default enabled.
5.6.6.3

Maintain Text Order

This Maintain Text Order option determines the whether the AFP
Printer should keep the text in the order it was received from the
application where the Print command is issued.
When this option is enabled, the received text is kept in order; when it
is disabled, the AFP Printer will order the text by font type and style
improving performance as a result.
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This option is by default disabled.
5.6.6.4

Font Type

Three options for Font Type are provided,
AFP Raster Fonts
AFP Outline Fonts
TrueType Fonts
We recommend TrueType fonts among the three options so as to get
the best output fidelity. Some AFP enabled printers require that the
printers are configured to accept TrueType fonts.
AFP Raster Fonts are fonts whose graphic character shapes are defined
by small raster patterns.
AFP Outline Fonts are fonts fully compliant to the Adobe Type 1 Font
standards, and graphic character shapes are defined by mathematical
equations rather than by raster patterns.
Please check with your printer manufacturer to see if your AFP enabled
printer supports TrueType fonts, Raster Fonts, and Outline Fonts.
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Text Support

This Text Support option determines the support level of text the AFP
Printer generates. Two options are available for Text Support, Basic and
Enhanced Color.
Basic
Text objects generated from AFP Printer are compliant to PT2 standards.
Enhanced Color
Text objects generated from AFP Printer are compliant to PT3 standards.
NOTE: PT2 standards only support the eight colors, red, blue, green,
black, magenta, cyan, yellow, and brown. Whereas PT3 standards
support a full spectrum RGB color space, i.e. all the 24-bit color values.
PT3 is not supported by all AFP enabled printers.
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Font Substitution

You can substitute a font in your table with a Windows font in the Font
Process Table frame.
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The Font Process Table frame contains three sub-frames,
For Font
Use AFP Character Set
TrueType Font Options
5.6.6.6.1 For Font

Choose a font in the For Font sub-frame as a replacement for the font
in your table.
Name
Specify the name of the Windows font such as Arial.
Style
Specify the style of the Windows font such as Regular, Italic, Bold.
Size
Specify the size of the Windows font selected.
When you select a font in the drop-down list of all the available fonts
installed on your Microsoft Windows system, the current substitution for
the selected font, if available, is shown in the Use AFP Character Set
sub-frame, as illustrated, C0H200B0 is for shown for Arial.
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5.6.6.6.2 Use AFP Character Set

Choose a font in the For Font sub-frame as a replacement for the font
in your table.
When you select a font in the drop-down list of all the available fonts
installed on your Microsoft Windows system, the current substitution for
the selected font, if available, is shown in the Use AFP Character Set
sub-frame. For example, C0H200B0 is a substitution for Arial.
You can add, modify, and delete a font substitution at any time. Any
AFP character set that is substituted should have metrics that closely
match the selected Windows font, or text in your AFP output will not be
correctly placed. You can avoid some of these errors by varying the
output fidelity.
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5.6.6.6.3 TrueType Font Options

Three options are provided in the TrueType Font Options sub-frame.
Create Reference
This option directs the AFP Printer to create references for TrueType
fonts, and it helps minimize the size of output files.
Create Inline Resource
This option directs the AFP Printer to embed a subset of TrueType fonts
as inline resources in the AFP output, and thus produce larger output
files.
Generate Image
This option directs the AFP Printer to rasterize the TrueType fonts and
store fonts as image rather than text objects, and therefore create the
largest output files.
Note: We recommend the Create Reference option for document
without text in special fonts. We suggest the choice of the Create
Inline Resource option for document with special fonts. We do not
advice the use of the Generate Image option unless the target printer
does not support TrueType fonts.
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Code Page

Code page is another name for character encoding, which consists of a
table of values describing the character set for a particular language.
The term code page originated from IBM's EBCDIC-based mainframe
systems.
The default code page for ASCII is T1001252 (Personal Computer:
Desktop Publishing). You can enter your own code page to be used by
the AFP Printer.
T1001252 works for most cases.
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Output Fidelity

Like the Use Text Rules option, the Output Fidelity options can be
used to trade off between speed, file size, and output fidelity.
Only text printed in substituted fonts will be impacted by the Output
Fidelity options, whereas text printed as image will never be impacted.
Three methods are provided for Output Fidelity,
Character
This method places each character individually according to the metrics
of the Windows font. provides the greatest fidelity, it causes the driver
to run slower and increases the size of your output file.
If the AFP character set that you are substituting has metrics that
closely match your Windows fonts, this method is rarely used unless you
do find incorrect character placement in the AFP output.
Word
This method places each word individually according to the metrics of
the Windows font, thus providing a good compromise between speed,
size, and fidelity. Recommended for most situations.
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Line
This method places each line individually according to the metrics of the
Windows font, thus generating the smallest output files that will be
printed much faster.
Though this method might cause words to overlap in some cases, it
provides considerable fidelity when your document is composed of
individual lines in the same font and proper font substitutions have
been set up in the AFP Printer.

5.6.7

Print text as image
This option allows you to print text as vector-based font objects or
rasterized images.
When this option is set to On, the AFP Printer processes text in your PC
document as text wherever possible with graphics and shading being
produced as image, and it makes it more efficient to produce text-based
overlays and documents in
terms of both the file size and the speed of viewing and printing.
When this option is set to Off, all text-based contents are processed as
a series of images rather than as vector-based text.
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We highly recommend this option to be set to On unless you find that
certain text is missing or certain type of fonts are misinterpreted in the
output AFP docs.
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More Advanced Options
Color Management options are available in the Color Management tab of
the AFP Printer Properties dialog, after you run the following command
in Start->Run,
rundll32.exe printui.dll, PrintUIEntry /p /n "AFP Printer"
Image Resolution and Compressed Images options can both be found in
the "Device Settings" tab,

6.1

Color Management
Color Management options are only available on Microsoft Windows
10/8.1/8/7/Vista/2008/2012 or later operating systems, which can be
found when you can go to your Control Panel->Printers and Devices, and
right-click on the "AFP Printer", and then choose "Properties".
Color Management options are on the Color Management tab of the AFP
Printer Properties tab, and you can specify an ICC profile for color space
conversion.

6.2

Image Resolution
Image Resolution can either be 300x300 or 600x600 DPI (Dot Per Inch).
The principle of the choice is to match your target printer.
Most laserjet printers, such as IBM, Oce, InfoPrint printers, use AFP
resources at 300 dpi even if they subsequently print the output at 600
dpi.
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Image Compression
Compressed Images option is set to On by default. If you turn this
option off, you get larger AFP document, page segment, or (medium)
overlay.
Most laserjet printers, such as IBM, Oce, InfoPrint printers, is capable of
decompressing images when a AFP document, page segment, or
(medium) overlay is printed.
This option is set to Off only when the target printer is old and does not
support image compression.
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Viewing AFP
AFP document, page segment, medium overlay, and overlay can all be
viewed by IBM AFP Workbench Viewer, a free program that help you
view and print AFP docs.
There exist many 3rd-party AFP viewers, but some of them can not
interpret or present AFP data stream correctly.

7.1

IBM AFP Workbench Viewer
IBM AFP Workbench Viewer Plug-in for Microsoft Internet Explorer
ftp://ftp.infoprintsolutionscompany.com/frominfoprint/Printers/products/
workbench/windows/service/gnsp32dm.exe
IBM AFP Workbench Viewer Standalone application
ftp://ftp.software.ibm.com/printers/products/workbench/windows/
service/ipsafpwb.exe
Both the plug-in and the standalone application are able to view and
print the AFP document, page segment, medium overlay, and overlay
with the following file extensions on Microsoft Windows
10/8.1/8/7/2000/XP/2003/Vista/2008/2012 and later operating systems.
Document: *.afp, *.AFP
Page Segment: *.psg,*.PSG
Medium Overlay: *.oly,*.OLY
Overlay: *.oly,*.OLY
The following type of resources are also supported by the IBM AFP
Workbench Viewers,
Form Definition: *.fde,*.FDE
JFIF: *.DOR,*.jpg, *.JPG,*.jfif,*.jpeg
GIF: *.DOR,*.gif,*.GIF
TIFF: *.DOR,*.tif,*.TIF,*.tiff,*.TIFF
CHARSET: *.240,*.300,*.OLN,*.oln,*.Oln,*.fnt
CODEPAGE: *.fnt
CODEDFONT: *.FNT
IBM AFP Workbench Viewers only allow you to view and print AFP
document but does not create AFP document, page segment, medium
overlay, or overlay. To create AFP docs, you are suggested to install the
AFP Printer, which can be obtained from,
http://www.afpdriver.com/AFPPrinter_Setup.exe
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Purchase
Why to buy?
The evaluation copy of the PDF to AFP Converter software expires after
15 days. You can purchase the full version of the PDF to AFP Converter
software from our resellers worldwide.
For more information on purchasing,
http://www.ipdsprinter.com/order-PDF2AFP.html
Billing & Payment
Billing currency: USD, EUR, GBP, AUD, CAD, JPY, CHF.
Payment options: Credit card, Debt card, PayPal, Wire Transfer, Bank
Check, Purchase Order etc.
NOTE: The simplest and fastest way to buy our software is to order it
Online.
Benefits of Purchase & Registration
After you purchase the full version, you will receive:
-

Use of the software beyond the 15-day trial period
No registration reminders
No hidden watermark on AFP files
Unlimited free upgrades
Product support by e-mail totally free.

Delivery Options
You can choose either of the following delivery methods:
1) Download: You will receive a download link to the full version
immediately after your order is processed.
2) Download + CD: You will receive a download link to the full version,
and the full version software will also be mailed to you on one CD-ROM.
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Registration
How to register your copy of PDF to AFP Converter?
Before registration you need to obtain a valid license code to turn your
evaluation copy into full version copy. If you don't have a license code,
you can purchase one from our store,
http://www.ipdsprinter.com/order-PDF2AFP.html
To register the PDF to AFP Converter software with your license key, you
should provide your license key in the Registration Reminder window.
The license key can be found in the order confirmation email sent by our
reseller.

If you do not wish to register, just choose 'Reminder me later'.
If you have trouble in registering your copy of the PDF to AFP Converter,
feel free to contact our support team at support@ipdsprinter.com.
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Support
If you have any question, feel free to contact us.
Contact Sales Representative
sales@ipdsprinter.com
Contact Technical Support Staff
support@ipdsprinter.com
Contact Reseller in North American
Share-it
c/o Digital River, Inc.
10380 Bren Road West
Minnetonka, MN 55343, USA
Languages: English
Phone: +1 952 646-5747 (for calls from outside the U.S.) or +1 800 9034152 (for calls within the U.S.)
Fax: +1 952 646-4552
Contact Reseller in European
Share-it - Digital River GmbH
c/o Digital River Ireland Ltd.
Unit 153
Shannon Free Zone West
Shannon Co. Clare
Ireland
Languages: English, German, French, Italian, Spanish and Portuguese
Phone: +49 221 31088-20
Fax: +49 221 31088-29
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